As chemistry instructors we know the challenge with teaching chemistry is the realm of chemistry is so vast that most of it is either too large to see, too small to see, too fast to see, or simply not in the classroom to be seen.

Let us start with the most common "seeing" problem, the microscopic world of atoms. If students could see at the atomic level, many of the obstacles in learning chemistry would just vanish. For example, you could just hold up a piece of chalk and ask, "What is the composition?"

With microscopic vision, students would see the calcium, carbon, and three oxygen atoms and just tell you.

There would be no need to memorize. For example, we do not memorize how many legs a horse has. We have seen horses and therefore know how many legs they have. That is the key in using PowerPoint. Show it and they will know it.

When you show "it," that does not mean words. Words are poor visuals for helping students "see." For example, what happens if the screen says, "And now for a Combustion
Disappointed? You may have expected a video of the crowd pleasing whistling pop of hydrogen burning in a test tube or at least an animation. What usually gets shown with PowerPoint are not reactions but static representations of reactions; in other words, text. Even paper could do that. It is a huge underutilization of computer technology to put static text on the screen.

Today's computers can display 16 million colors at frame rates four times faster than movie film. Also, the resolution (detail) of computers beats DVDs fourfold.

On top of that, the audio capabilities of many computers include five-channel surround sound, the same as a movie theater.

Today's computers (even the cheapest ones) can deliver virtual reality at low cost.

Teachers have at their fingertips the tools to engage students and show concepts with a level of clarity never before possible.

Why do so many settle for bulleted...
PowerPoint is the first step to getting the most out of your computer-assisted presentations and to show chemistry bigger than life.

The problem of underutilizing computers in teaching could have originated in teaching via chalkboards. Since it was not possible to use millions of colors, pictures, or animations, lecture materials were primarily text-based. When computers came to the classroom, these lecture materials were simply ported to the computer.

*PowerPoint*, like computers, also fell victim to huge underutilization.

**LET'S BAN LECTURE NOTES**

Despite what you have seen, *PowerPoint* was not invented to take lecture notes and project them onto a screen.
PERCEIVE POWERPOINT AS MEDICINE

When I teach PowerPoint workshops, I do not begin by teaching what menus or buttons to click; I start by explaining how PowerPoint should be perceived. There are three useful ways to perceive PowerPoint. The first way is to treat it as medicine.

Look at PowerPoint as a drugstore, allowing you to select and dispense the medication your students need...

...and you need to be quick before
you lose them completely.
Yes, there are various conditions students have that need "medical" attention.
Below are three areas that require remedies.

**PROBLEMS IN LEARNING:** Attention could be focused on the psychological and physiological symptoms stemming from misunderstood words, lack of mental images, and fast pace learning. The symptoms include: irritability, headaches, weighed-down feeling, feeling of incompetence, and confusion, to name a few.

**INAPPROPRIATE EMOTIONS:** You may need to alleviate apathy, fear, boredom, or anger.

**INAPPROPRIATE BEHAVIORS:** The way students do things (e.g., lab techniques) or the way they act (e.g. tardiness) may need modified.

Instead of tackling the ailment, many teachers usually use PowerPoint to simply display information.

This is just like having a patient read their prescription bottle label and expecting them to be cured.
Yes, the label is informative, but it has no medicinal value.

In other words, information is informative, but, alone, it may have no medicinal power to cure what ails your audience.

What does this mean as far as designing a PowerPoint presentation?

It means that you do not just think about what information needs to be shown, but what effect you want to have upon the students. For example, when I give a presentation about the minerals that early humans learned were useful in making stone tools, I actually want students to feel fear.

So before I dive into an informative discussion of silicon dioxide and microcrystalline minerals such as chert, flint, agate, and obsidian, I consider the medicinal power of the presentation.
In other words, I know I want to cure the apathy that may be towards a list of minerals used by humans thousands of years ago. My series of "medicinal compounds" are first dispensed to create a sense of fear, followed by a sense of relief and then appreciation as this early chemical knowledge kept humans from going extinct. The next effect planned is surprise. I show them how this ancient stone tool technology is still the preferred material for some items for chemistry labware and surgical instruments.

So I begin with a series of images to create fear, the same fear that our ancestors experienced when confronting predators.

To download this PowerPoint click here. (Note: This is the PowerPoint I use, but it has no narration. It is also about 7 megs.)

To see a web version of this presentation, go to this Web tutorial.
It includes a written narration.

In all presentations, look at the medicinal power that *PowerPoint* has to either induce effects you want or to cure ailments the students have. Place information within this context. Otherwise, (provided that they don't go to sleep) students may memorize information but not see its relevancy or have an emotional connection to the information. The relevancy and emotional connection created with imagery will help keep this knowledge in long term memory.

**PowerPoint Perception Two: A Magician's Hat of Tricks**

I mentioned that there are three ways to perceive *PowerPoint*. The second way is to realize it has the power of a magician's hat of tricks, and you are the magician. Being a chemistry teacher, the word "sorcerer" may be more fitting.

Either way, below represents the type of magic you have at your disposal when using *PowerPoint*. 
In the image below, I created a composite of images to make a colorful skyline of a city attuned to chemistry. The image has 16 million colors, 14 million more than your eyes can even see. It's my logo image for my Chemistry & Society online course.

I created this image for my history of the Periodic Table *PowerPoint* presentation. Again, the use of colors help spot the various chemical groups and lets me transition from the early four "element" table.
For a tutorial on global warming, I made an image by putting a wool cap on the Earth and giving the Earth a stressed out face. This kind of imagery gets and holds attention while information is delivered. The image connects to students at both logical and emotional levels.

You don't have to create your own images. There are millions of images on the Web that are in public domain or that you can use under fair use policies.
Here is a carbon nanotube. Note that images I show in this article are about four times smaller than I show in a *PowerPoint* presentation.

My favorite search engine is *Google*. Besides the useful default Web search, use the *Images* search category.

For example, if you type "molecule" in the search field, *Google* will begin to show thumbnails of all images it knows that uses that word. Below you see it found 69,100 images. Here I'm showing just the first nine. When you click on the thumbnail image, you are taken to the Website that has the image. (I like to search for "large" images by clicking on "Large" indicated by my yellow arrow.)
You are now at the site with the image. Click on that thumbnail again (which is now at the top of the screen) and you will see the full size image.

When the full-size image appears, click on it with the right mouse button and choose "Save Image As..." and then save it in a folder where you can find it.
In PowerPoint, insert the image by clicking on the Insert menu and then the Picture submenu. Choosing the "From File" selection will let you browse to the file you saved.

Once the picture is inserted, you can resize it by dragging one of the corners (blue arrow). Cropping the picture is possible by using the cropping tool (yellow arrow) which is on the Picture toolbar. Click on the image to make the Picture Toolbar appear. If it doesn't, go to the View menu and go to submenu, Toolbars, then checkmark Picture.
Regarding imagery, *PowerPoint* also allows images to be placed in Word Art text for extra impact.

It also supports GIF anims like the fire GIF anim here.

*PowerPoint* supports a variety of animation techniques. As mentioned, it supports GIF anims. I made the below animation as a GIF anim that can be played in *PowerPoint* or on the Web. Roll the mouse over the helix. Notice how animation helps your brain process the image.

To find GIF anims or clip art, you
can click on the *Clip Art* button at the bottom of the *PowerPoint* window (left yellow arrow). When that is clicked, the Clip Art task pane window appears. You can type in the topic to search (top yellow arrow). Also, click on *Clip art on Office Online* (bottom yellow arrow). It will search for all media types (clip art, photos, movies, i.e., GIF animations, and sounds.) or you can click on just the type you want.

Click on a thumbnail listed and drag it onto the *PowerPoint* main screen. Note the GIF animations will not animate until you go into presentation mode.

As I said, *PowerPoint* supports a variety of animation techniques to add to your magician's hat of tricks. Two others involves *motion paths* and *emphasis effects*. *PowerPoint* has some great animation tools for creating animations quickly.

The animation on the left was created using *PowerPoint*. To see the animation, roll mouse over the image.

To see a more sophisticated one I created in *PowerPoint*, click here. (The PowerPoint screen was scaled down 50% and converted to a Quicktime movie). Click back on browser to return to this page.

At the end of this article, I have a link to a page with many *PowerPoint* presentations you can download and run.
PowerPoint is good for chemistry animations. For example, it has effects called Emphasis effects which includes the Spin effect. The two inner electrons of lithium were grouped (see upper yellow arrow). Then by applying the Spin effect, the electrons in orbit are made to spin. Other settings let you set how many times it will spin and how fast.

For the outer single electron, I used the Circle Motion Path effect. If you don't see the Circle effect listed, click on "More Motion Paths..." (bottom yellow arrow). Again, there are other settings to set the speed and repetitions of the circling.

Motion paths allow for all kinds of chemical reactions to be animated.

For example, I wanted to show a radical chain reaction for ethylene. To the left is a static image of the basic process. By using motion paths and the spin effect, I created an animated version, which is much more clear. Roll mouse over image to see animation.

The other two effects, Entrance and Exit round out PowerPoint's arsenal of effects. These allow objects to appear and disappear, fly in or out, and many other useful effects.
The last two versions of PowerPoint (2002 & 2003) are totally different from the early versions regarding animation. These new versions are a quantum leap above the early versions and comparable to programs like Flash.

I have worked with computer animation programs for 25 years and have never seen any animation program as easy to use as PowerPoint. PowerPoint's powerful capabilities are very much unrecognized, even by those who work with animation daily.

Earlier I mentioned that in PowerPoint's hat of magic tricks, sound was also available. I don't usually use PowerPoint's built in sounds; they are sometimes annoying. But for specific purposes, sound is great. For example, as my presentation moved towards a discussion of the Big Bang, I talked about how the speed of galaxies were measured using Doppler shifts. I played Doppler shift sounds that a train and airplane make. I also included the sound of an ultrasonic Doppler flow detector (for the
To insert a **sound**, go to the Insert menu, then down to "**Movies and Sounds.**" Go across and choose "**Sound from File...**". This lets you browse to the sound file that you may have saved from the Internet or recorded yourself.

Notice, this is the same way to insert a "**Movie from File...**".

To find sounds on the Internet, I also use Google. It does not have a sound category like it does images, but you can use the normal search for Web pages to find sound files.

For example, let's search for train sounds. In the Google search field type in "trains sound wav mp3 aiff." The last three words are common sound formats. So this will help it find sites with digitized sounds. Beware of some of these sites. They may have a lot of ad-ware that can infect your computer. I use the free "Ad-Ware SE Plus" program that can erase these from my computer.

A safer place to get sounds is from Microsoft via PowerPoint's clip art menu. Remember, before we used it to find GIF animations. It also has...
sound files. Again, if you click the clip art icon and then Clip art on Office Online icon link (same as shown above), you can search for sounds. Just uncheck the other media types, if you want just sounds.

Here I did a search with only the Movies and Sounds media types checked. Animations are indicated by the moving star icon. Sounds show their name with the Winamp logo.

Clip art, animations (movies), and photographs are dragged from the clip art window onto your screen. For sounds, you need to double click the sound and it will ask if you want the sound to play automatically or manually. Automatically means it will play in sequence with other animations you may set up. Manually means you must click on the speaker icon to play the sound. This is up to you.

Here again are the tricks you can pull out of your hat when making presentations.
PowerPoint Perception Three: A Picture Window to the World

The third way to perceive PowerPoint is as a Picture Window to the World. This is the easiest way to get the most out of PowerPoint. The idea of using imagery has been covered above, but it's worth reinforcing.

Like I said at the beginning, "Show it and they will know it."

In the past I bought all kinds of clip art CDs to have images to show. But with the Internet at my fingertips, I can find images much faster and of more variety.

There's an interesting psychology behind the size of images. If you show images that are smaller than the screen, you simply see an image on the screen. Here I took a picture of a picture window. From this viewpoint I could see the scenery that was outside. However, when I got close to the window and it filled my field of view, it seemed I was now outside. Roll mouse over image. (You won't get the full effect because the image here does not fill the screen).
The trick then is to use full-screen images whenever possible. Students won't just think they are looking at an image, but be transported to that location.

So, I usually show images full-screen for full impact, then I bring in the information that goes with that image. (Roll mouse over image for the fission equation.) Both photograph and equation are symbols of fission. The image, however, makes it more real and reaches you at an emotional level. That, combined with the details in the equation, makes for well-rounded and well-retained knowledge.

In closing, I want to say I like putting together presentations. By using the tips I've covered, the presentation becomes enjoyable to me. If I enjoy it, I find students will too.

I also don't do all teaching with
PowerPoint; demonstrations and hands-on activities are used as well. Sometimes I even combine theatrics, PowerPoint, and demonstrations for more memorable presentations.

Again, PowerPoint is great at showing what is either too large to see, too small to see, to fast to see, or simply not in the classroom to be seen.

To see examples of PowerPoint animations, I've taken pieces of my presentations and assembled them into a demo. I have a few other presentations that are also instructive.

Download PowerPoint Demo (4 Meg)
Download Hybridization PowerPoint (2 Meg)
Download PV=nRT PowerPoint (4 Meg)
Download Claisen Condensation PowerPoint (2 Megs)

I have some other links on my CHM130 homepage. http://www.chemistryland.com/CHM130/chm130home.html

I store these materials at my site called, "Chemistryland" at the URL, www.chemistryland.com. My hope for the future is that it will become a good resource for students and teachers.

During the online conference, Brian Pankuch asked some questions that I think is best answered with using a Web page. The questions and responses can be found here.

Thank you for reading this article on how computers can be used in chemical education. Thank you for reviewing the
above PowerPoint examples. I hope you got some new ideas on how to make better use of a tool you already have and are using.

You can email me at costello@chemistryland.com

You can return to the Computer in Education Newsletter Home page with the below link.

CCEN Newsletter Home Page for Fall 2005

Number of readers (not just hits) since Sept 25, 2005 275149